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INTRODUCCIÓN 

 
 

Cada día se  incrementa la tendencia del computador en el diseño 

estructural, tanto  a nivel de pregrado, como de postgrado. Más aún en la 

UCAB, donde se cuenta con la Licencia del programa SAP2000 a la 

disposición de todo el alumnado y personal docente.  Este software permite 

extenderse en  casos prácticos y complejos a nivel de investigación 

relacionada con el diseño estructural, que usualmente son difíciles de realizar 

utilizando procedimientos manuales. 

Los manuales del SAP2000 suelen estar expresados en códigos que 

sólo son entendidos por un grupo estricto de personas especializadas, lo que 

dificulta su comprensión por parte de individuos ajenos a su funcionamiento. 

Además de ser el SAP un programa desarrollado para normativas 

extranjeras, involucra una serie de parámetros que originan  resultados del 

diseño estructural poco explícito para aquellas personas que no tengan el 

dominio necesario que les permita interpretar los valores arrojados por el 

computador. 

 Por todo lo antes expuesto, es relevante que el estudio de esta guía 

para utilizar eficientemente el SAP resulte de interés para todas aquellas 

personas dedicadas al estudio del diseño estructural tanto profesionales 

como estudiantes, puesto que este señala cada una de las opciones, 

herramientas y analogías de los resultados arrojados por el programa y los 

obtenidos analíticamente según las normas venezolanas. 

 
 
 



OBJETIVOS 

 

 Desarrollar una guía de aplicación del programa SAP2000 en su 

versión 11, sistematizando sus herramientas y opciones de forma 

explícitas para que el usuario pueda interpretar los resultados 

arrojados por éste. 

 

 Establecer el vínculo entre el cálculo manual y el cálculo automatizado 

de estructuras de acero y concreto que faciliten el uso del programa 

en los  cursos. 

 

 Desarrollar un manual dirigido a la solución de casos específicos, que 

con frecuencia se presentan en el diseño estructural.  

 

 Desarrollar un manual del programa SAP2000 en su última versión 11 

que sirva de guía a nivel de pregrado, extensión universitaria y 

postgrado.  

 

 

 
 
 
 
 
 
 
 
 
 
 



RESUMEN 
 

 
Elaborar una manual de aplicación del SAP2000 en su última versión 

V11 plantea un guía del programa para fines docentes. En el se emplea una 

metodología que ayuda tanto a ingenieros como alumnos de pregrado o 

postgrado dedicados al diseño estructural.  

En la guía se explica, paso a paso, el significado de las opciones del 

programa, para que el usuario tenga las herramientas necesarias al 

comparar y analizar los resultados obtenidos del diseño asistido por el 

computador con los derivados analíticamente.  

En el Capítulo I se presenta una introducción teórica donde se 

exponen claramente cada uno de los elementos constitutivos del menú y 

barra de herramientas, así como el uso y aplicación de los ejes en Sap. 

Igualmente, se esbozan las tareas comunes encontradas entre el Sap 

y Autocad. Esta aplicación sirve de instrumento eficaz al realizar labores 

donde confluyan estos software.  

En el Capítulo II se estudia la aplicación de vínculos externos en 

internos  tipo rodillo, empotrado, articulado, nodo y biela.  

En el Capítulo III comprende el análisis y diseño de una estructura 

tridimensional para distintos casos de cargas, acciones sísmicas, análisis 

dinámico y estático. 

En el Capítulo IV se hace uso de líneas de influencias para cargas 

móviles: un vehículo sobre un puente. 

En el Capítulo V se estudia el modelaje de elementos tipo cables 

analizando su comportamiento lineal y no lineal. 

En el Capítulo VI  se plantea el modelaje con elementos finitos de 

losas, escaleras, tanques, fundaciones y muros. 

 



Obtener un manual de tan poderosa herramienta es de gran utilidad 

para el cálculo estructural, siempre que se emplee de forma correcta sin 

pretender que el programa sustituya el buen juicio del profesional. 
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CAPÍTULO II  

COLOCACIÓN DE VÍNCULOS EXTERNOS E INTERNOS 

 

II.1 Ejemplo 1:  

 

Determinar las reacciones, diagramas de fuerzas axiales, cortantes y 

momento de la figura mostrada. 

 

 

 

Solución. 

 

1. Seleccionar unidades. En el extremo inferior derecho se ubican las 

unidades deseadas, de acuerdo a fuerza, longitud y temperatura. 



 

2. Hacer clic en File menú → New model. Este menú muestra una 

ventana con diferentes tipos de modelos. Se debe seleccionar para 

este caso Grid Only  

 

 

 

3. Al seleccionar Grid Only, aparece una nueva ventana donde se 

colocan las longitudes y distancias de la malla a utilizar. Las 

coordenadas aquí dispuestas pueden ser cartesianas o cilíndricas.  

 



 

Posteriormente, aparecerá en pantalla dos ventanas con vistas de la 

malla creada, una con vista 3D (derecha) y la otra en el plano XY con 

las dimensiones que se le dieron anteriormente. Por comodidad debe 

trabajarse en el plano XZ, seleccionándolo en la barra de menú.  

 



 

 

Al utilizar el icono Draw Frame/Cable Element, ubicado en el lado 

izquierdo de la pantalla, se editará la malla de acuerdo al ejemplo 

propuesto. 

 

 

 

Draw Frame/ 
Cable Element 
 
 
 
 
 



4. Seleccionar donde se desea colocar el rodillo A y seleccionar la 

opción Assign del menú principal → Joint → Restraints. 

 

 

 

Después de ésto, aparecerá una nueva ventana donde se muestran 

los distintos tipos de vínculos externos. En este caso particular se 

selecciona el rodillo.  

 



 

Este procedimiento se repetirá para la colocación del vínculo tipo 

articulación en el punto C. 

 

5. Para rotar los apoyos se debe indicar el vínculo deseado y seleccionar 

en el menú principal  Assign → Joint → Local Axes. Después de 

ésto aparece la siguiente ventana.  

 

 

El eje de rotación del vínculo será el perpendicular al plano en el cual 

se está trabajando, en este caso es el eje Y, ya que la estructura se 



encuentra en el plano XZ. Este procedimiento se repite para el otro 

vínculo. 

 

 Si se desea que el vínculo rote en sentido horario, el valor a colocar 

debe tener signo positivo y  si se desea antihorario se pondrá signo 

negativo a este valor. 

 

6. Para colocar la fuerza aplicada en el punto B, se debe seleccionar 

éste y seguir la función Assign → Joint Loads → Forces. 

 

 

 

La fuerza debe ser colocada según la dirección del eje donde esté 

aplicada. En el ejemplo presentado la dirección de esta fuerza 

corresponde al eje Z. Aquí se verifica que las unidades de trabajo son 

las establecidas en el paso 1 del ejercicio.  

 



7. Para analizar la estructura anteriormente preparada, se procede a 

hacer clic en  de la barra menú. Luego de este proceso aparecerá 

la siguiente ventana. 

 

 

 

Se debe seleccionar el caso MODAL indicando Action Do not Run, 

para que éste pueda correr de forma correcta sin incluir las fuerzas 

generadas por un sismo, esto se realiza haciendo clic en Run/Do Not 

Run Case. Luego se procede hacer clic en Run now, generándose la 

corrida. 

 

 



 

 

 

Al presionar OK se abrirán nuevamente las dos ventanas que se 

tenían inicialmente, mostrando la deformada por carga permanente en 

la ventana 3D. Una vez corrida la estructura, toda la información 

numérica y gráfica se puede ver en el menú Display.  

 

 



                                                    

                                                              

                                                                                                         

  Display – Show Forces/ Stresses… 

 

En esta opción se pueden ver los diagramas de corte, momento, 

fuerza axial y  esfuerzos en todas las direcciones de cada elemento. 

 

 

 

Al hacer clic en joints se tendrán las reacciones generadas en los 

apoyos y en el caso de frames /cables se observarán los diagramas 

Mostrar las cargas asignadas. 

 
Mostrar las propiedades de algunos elementos. 

 

Mostrar las estructura sin deformaciones. 

Mostrar las deformaciones de la estructura. 

 
Mostrar los diagramas de fuerzas y esfuerzos. 

 
Mostrar los diagramas de trabajo virtual. 

 

Mostrar las tablas de resultados del análisis. 

 

 



de las fuerzas deseadas, axial, corte o momento. Se pueden 

seleccionar según sea el caso, como se muestra en la siguiente la 

ventana: 

 

 

Al hacer clic con el botón derecho del mouse sobre cualquier elemento 

de la estructura se podrán ver los valores y todos los diagramas del 

elemento seleccionado. 

 



 

 

Nota: Es importante recordar que el programa considera el peso 

propio de los materiales, esto implica que los resultados obtenidos no 

se ajustarán a los calculados por los métodos convencionales. Por 

ello, se debe indicar en el programa que no se considere el peso 

propio. Esto se logra haciendo clic en Define → Materials, en donde 

aparecerá la siguiente ventana. 

 

 



 

En esta ventana se selecciona el material, para luego hacer clic en 

Modif/Show Material. Al hacer esto, se entrará en una ventana donde 

se podrán ver las propiedades del material. Es aquí donde se puede 

modificar la unidad de peso por volumen, al hacerla cero estamos 

eliminando el peso propio de las estructuras.  

 

 

 

 Para realizar modificaciones sobre el diseño realizado es necesario 

hacer clic sobre el ícono    para abrir el candado y así el programa 

permita hacer los cambios necesarios. Es importante saber que esta 

opción también se utiliza para eliminar los archivos que no son 

necesarios generados por la corrida. De esta manera se guarda la 



estructura y el SAP elimina automáticamente los registros no utilizados 

pertenecientes al análisis.  

 

Al realizar los cálculos manuales se comprueban los resultados 

arrojados por el computador: 

 

-10.Cos45*Ra  + 5*(10000) = 0   →    Ra= 7071,06 

 

 

 

 

 

II.2 Ejemplo 2:  

 

Determinar las reacciones, diagramas de fuerzas axiales, cortantes y 

momento de la figura mostrada. 

 

 

 

 

Este ejemplo en particular, presenta una articulación en B y en C, la 

cual impide el paso de fuerza cortante entre las barras (Biela de corte). 

 



Solución: 

 

1. Este primer paso se refiere al cambio de unidades. Se procederá igual 

que en el ejemplo 1. En la esquina inferior derecha se selecciona la 

unidad deseada de trabajo. 

 

2. El tipo de modelo a utilizar es el mismo que en el ejemplo 1. Ver paso 

2. File menú → New model → Grid Only. 

 

3. Este paso hace referencia a las dimensiones del Grid, así como las 

longitudes. Estas variarán según las especificaciones del ejemplo. 

Como en el ejemplo 1, se busca la vista XZ para poder trazar la 

estructura a estudiar con la opción de Draw Frame / Cable Element 

ubicado a la izquierda del menú.  

 

4.  Para colocar vínculos el proceso es igual al ejemplo 1, paso 4. Se 

indica la posición del vínculo, para luego seleccionar  del menú 

principal la opción Assign → Joint → Restraints. Así se definirá el 

tipo de vínculo deseado para este ejemplo. 

 

5. Para definir la articulación en B, se debe seleccionar la barra AB y 

hacer clic en la opción  Assign → Frames → Releases/Partial 

Fixity…. 

 



 

 

Esta opción permite restringir, ya sea fuerza axial, fuerza cortante o 

momentos en los extremos de las barras. Se sabe que en una 

articulación los momentos no se transmiten entre las barras, así como 

la torsión. Al hacer clic en la referencia anterior aparecerá la siguiente 

ventana. 

 



 

 

En esta ventana se especifica que fuerza se desea restringir y en que 

extremo de la barra. En este caso, como se seleccionó la barra AB, A 

será Start y B será End. Como se está especificando que es una 

articulación en B sobre la barra AB marcamos de la siguiente forma. 

 

 

 Así se indica que la unión es una articulación. 

Fuerza a 

Restringir 



 

Nota: Este proceso se puede realizar con la barra BC. Se debe tomar 

en cuenta que ahora B sería Start y C End. 

 

6. Para definir la biela en C se procede igual que el paso 5, Assign → 

Frames → Releases/Partial Fixity. En este caso, como se desea 

restringir el paso de fuerza cortante entre las barras BC y CD, en la 

ventana se escoge la correspondiente a esta fuerza en el extremo de 

la barra que se haya seleccionado. En este caso se tomó la barra CD.  

 

 

 

7. Para indicar el momento en el vínculo B, se debe seleccionar primero 

el punto donde será aplicado, para luego aplicar Assign → Joints 

Loads → Forces como se hizo en el ejemplo 1 paso 6. Al ser este un 

momento se debe de colocar el valor del mismo en la casilla que 

represente el eje en el cual se esta aplicando. En este ejemplo el 

momento gira alrededor del eje Y.  

 

Fuerza 

Cortante 



 

 

8. Se analiza la estructura realizando el mismo procedimiento del 

ejemplo 1 paso 7, haciendo clic en  de la barra de menú. 

 

9. Para chequear que se ha restringido el corte en las barras BC y CD, 

basta con hacer clic con el botón derecho del Mouse a la barra. 

Después de esto, aparecerá una ventana donde se muestran los 

diagramas de la barra seleccionada y donde se verifica que el corte es 

cero. En este caso, se pidieron los diagramas de la barra CD. 

 



 

 

Es importante recordar que el programa tomó en cuenta el peso propio 

de lo materiales. Para que los resultados coincidan ver nota del 

Ejemplo 1. 

II.3 Ejemplo 3:  

 

Determinar las reacciones, diagramas de fuerzas axiales, cortantes y 

momento de la figura mostrada. 

 



 

 

 

1. Este primer paso se refiere al cambio de unidades. Se procederá igual 

que en el ejemplo 1. En la esquina inferior derecha se selecciona la 

unidad deseada de trabajo. 

 

2. El tipo de modelo a utilizar es el mismo que en el ejemplo 1, paso 

2.File menú → New model →  Grid Only. 

 

3. Este paso hace referencia a las dimensiones del Grid, así como las 

longitudes. Estas últimas variarán según las especificaciones del 

ejemplo. Tal y como en el ejemplo 1, se busca la vista XZ para poder 

trazar la estructura a estudiar con la opción de Draw Frame / Cable 

Element ubicado a la izquierda del menú.  

 

4.  Para colocar los vínculos, el proceso es igual al paso 4 del ejemplo 1. 

Se indica la posición del vínculo, para luego seleccionar  del menú 

principal la opción Assign → Joint → Restraints, y así definir el tipo 

de vínculo deseado para este ejemplo. 

 



5. Para rotar los vínculos se procede igual que en el paso 5 del ejemplo 

1,  Assign → Joint → Local Axes. 

 

6. Para definir la articulación en D, se sigue el paso 5 del ejemplo 2, 

Assign → Frames → Releases/Partial Fixity, restringiendo en el 

extremo de la barra donde esté la articulación los momentos y la 

torsión. 

 

7. Para la restricción de fuerza axial en C entre las barras BC y CD, se 

busca en el menú principal Assign → Frames → Releases/Partial 

Fixity, tal y como se realizó en el paso 6 del ejemplo 2. Esta vez se 

selecciona la opción que restringe la fuerza axial 

 

 

 

 

8. Para colocar las fuerzas actuantes, se procede igual que en el paso 6 

del ejemplo 1, Assign → Joint Loads → Forces, recordando las 

nuevas direcciones de las fuerzas y de los momentos. En este 



ejemplo, la fuerza viene aplicada en X y el momento es alrededor del 

eje Y 

 

9. Se analiza la estructura realizando el mismo procedimiento del paso 7 

del ejemplo 1, haciendo clic en  de la barra de menú. 

 

10. Para chequear que se ha restringido la fuerza axial en las barras BC y 

CD basta con hacer clic con el botón derecho del Mouse sobre 

cualquier barra, así aparecerá una ventana donde se muestran los 

diagramas de la barra seleccionada y donde se verifica que el corte es 

cero.  

 

 



 

Es importante recordar que el programa tomó en cuenta el peso propio 

de lo materiales. Para que los resultados coincidan ver nota del 

ejemplo 1. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



CAPITULO III 

ESTRUCTURA TRIDIMENSIONAL, CASOS DE CARGA, 

ACCIONES SÍSMICAS, ANÁLISIS DINÁMICO Y ESTÁTICO. 

 

III.1 Ejemplo 4 

 

Análisis y diseño sismorresistente de una estructura de Concreto. 

 

 Edificio simétrico de 4 columnas 

 en ambos ejes con una distancia  

 entre ellas de 6 metros. 

 Número de pisos: 15 

 Altura entre pisos: 3m 

 Columnas de sección cuadradas  

de 70x70 cm  

 Vigas de sección  

rectangular de 60x40 cm. 

 

 

 

Solución: 

 

1. Selección de unidades: kgf, m, C. En la esquina inferior derecha como 

se indica en el ejemplo 1. 

 

2. Hacer clic en File menú → New model. Este menú muestra una 

ventana con diferentes tipos de modelos. Se debe seleccionar para 

este caso 3D Frames. 



 

 

3.  Al seleccionar 3D Frames. Aparece una nueva ventana donde se 

colocan las longitudes, número y altura de los pisos del edificio a 

diseñar. 

 

 

Number of Stories → Número de pisos. 

Number of Bays → Número de pórticos en los ejes X y Y. 

Story Height → Altura de pisos. 

Bay Width → Distancia entre los pórticos de los ejes X y Y. 

 

4. En la barra de menú principal se selecciona Define → Materials… 

Aquí se definirá el material con el que se va a trabajar.  

 



 

El programa brinda una serie de materiales como el acero, concreto, 

aluminio, entre otros. También se cuenta con la opción Modif/Show 

Material para crear otro material que no este en la lista, siempre y 

cuando, se conozcan todas las propiedades del mismo. En este 

ejemplo se utilizará concreto (280kgf/cm2 lo que es igual a 4000Psi). 

 

5. Una vez definidas las propiedades del material se presiona OK y se 

define las secciones a utilizar. 

 

 Define → Frame Sections… 

 

 

Agregar Nuevo 
Material 

Mostrar o 
Modificar 
Material 

 

 
 
 
 
 
 
 
 
 



 

En esta opción se puede definir columnas, vigas, arriostramientos y 

otros miembros. 

 

Al seleccionar Add New Property, se obtendrá una nueva ventana 

que permitirá indicar el tipo de material y la sección que se desea 

utilizar. Para este ejemplo, se empleará una sección de concreto 

rectangular. 

 

 

 

Luego, se tendrá una nueva ventana donde se indicarán las 

características de la sección a utilizar. 

 



 

Para mayor manejabilidad se le puede asignar nombre a la sección. 

En este caso se coloca COLUMNA en el recuadro de Section Name. 

 

Las dimensiones de la sección se colocarán en los recuadros 

correspondientes a Depth (Ancho) y Width (Alto).  

 

Es importante especificar que la sección definida es una viga o 

columna, para que el programa considere los aceros por corte en el 

caso de las vigas. Esto se indica haciendo clic en Concrete 

Reinforcement. Después de esto, se abrirá la siguiente ventana. 

 



 

 

En esta ventana se define que tipo de sección es, logrando así que el 

programa calcule los aceros requeridos para el corte en las vigas. 

 

6. Define → Area Sections 

Esta opción se utiliza para los elementos tipo área como paredes, 

pisos y otros miembros de sólidos bidimensionales. En este caso, se 

utilizará para crear la losa de piso. 

 

 



 

 

Se selecciona una losa tipo Shell para este ejemplo. Al hacer clic en 

Add New Section aparecerá otra ventana donde se indicarán las 

características de la losa. 



 

 

7. Define → Load Cases… 

En esta opción se definirá los casos de carga, estas son las fuerzas 

aplicadas sobre la estructura como presión, desplazamientos de 

apoyos, cambios de temperaturas, viento, sismo, entre otros. 

Los casos de carga a definir son peso propio, carga permanente, 

carga variable y  sismo.  

     

 

Tipo Shell: Un elemento que 
se deforma en su plano y fuera 
de su plano. Ejemplo: Losas, 
muros o placas macizas. 
 
Membrana: Un elemento que 
solo se deforma en su plano y 
no permite deformación fuera 
de este. Ejemplo: Techos, 
losaacero, losas de tabelones 
etc. 
 
Plate: Un elemento que no se 
deforma en su plano y solo 
permite deformaciones fuera 
de este. Ejemplo Losa 
nervada. 



 

Se especifica el nombre de la carga en Load Name y el tipo en Type, 

para luego hacer clic en Add New Load. Al hacer clic aquí, se estará 

introduciendo los distintos tipos de cargas que afectan a la estructura.  

 

8. Define → Funtions → Response Spectrum… 

Esta opción define el espectro de diseño. La función de espectro se 

crea para representar los efectos de las fuerzas sísmicas. 

Conociendo las características de la estructura, suelo, zona sísmica, 

nivel de diseño y haciendo uso de los capítulos 4, 5, 6 y 7 de la norma 

Sísmica Venezolana Covenin 1756-1:2001 “Edificaciones 

Sismorresistentes”, se buscan los parámetros correspondientes para 

la elaboración del espectro sísmico. Para este ejemplo se suponen las 

condiciones en las que se encuentra la estructura. Se emplea en una 

zona sismica número 5 (capítulo4) en un suelo firme/medio denso tipo 

S3 y correspondiente al grupo A (sección 6.1.1). Por ser una 

edificación aporticada capaz de resistir la totalidad de las acciones 

sísmicas y ser Nivel de Diseño 3, el factor de reducción de respuesta 

es igual a 6, valor dado en la tabla 6.4 aplicada en concordancia con 

la sección 6.2.2. Con estos parámetros y las ecuaciones que indica la 

norma mencionada, en la sección 7.2 del capitulo 7 se realiza el 

espectro de respuesta elástico  Período vs. Aceleración. El período se 

tomará hasta 1,6xTa según lo establecido en el articulo 9.6.2.1, donde 

Ta está dado en la subsección 9.3.2.2 de la norma antes nombrada, 

siendo 1,6xTa = 1,39 seg para este caso. 

Para introducir el espectro se debe copiar y guardar los valores de la 

tabla Período vs. Aceleración en un Notepad, esto se debe a que el 

programa sólo lee archivos .TXT. Es importante tener en cuenta el uso 

de puntos y comas en los valores del espectro. 



 

 

 

Luego se hace clic en Define → Funtions → Response Spectrum… 

donde aparecerá la siguiente ventana. 

 

 

 



Se selecciona en la pestaña de Choose Function Type to Add, la 

opción Spectrum from File y se hace clic en Add New Function. Al 

hacer esto se abrirá la siguiente ventana. 

 

 

En esta ventana se hace clic en Browse y se busca el archivo .TXT, 

donde se guardaron los datos antes mencionados. Es importante 

indicar que los valores que se están introduciendo son Período vs. 

Aceleración, esto se hace en el cuadro de Values Are, Period Vs 

Value. Para comprobar que las gráficas son las mismas se puede 

hacer clic en Display Graph y se mostrará la gráfica correspondiente 

al espectro.  

Otra opción de esta ventana es Convert to User Defined, al hacer clic 

aquí se está eliminando la dependencia del espectro al archivo, es 



decir, ahora el espectro queda directamente guardado en el programa 

y no depende del archivo. 

 

9. Define → Análisis Cases… 

En esta opción se definen los casos de análisis a considerar. En 

Analises Cases, se especifica cómo serán aplicadas las cargas a la 

estructura, así como la respuesta estructural que se origina. El 

programa brinda distintos tipos de casos de análisis clasificados como 

lineal o no lineal. La respuesta de la estructura a la carga dependerá 

de estos tipos de casos. 

 

 

 

En la presente ventana se pueden realizar varias operaciones. La 

primera será modificar el caso de análisis denominado DEAD (peso 

propio), en el cual se va a sumar los casos estáticos. En este caso 

preciso sólo CP (carga muerta), haciendo clic en Modif./Show Case… 

Se Elimina el caso CP de la tabla ya que se considera que la carga 

permanente actúa en el caso DEAD. 

 

Según sea el caso se debe modificar en Análisis Case Type el tipo 

de análisis. 



 

 

 

Análisis Modal 

Se usa el modo de Vectores de Ritz, y se especifican las 

aceleraciones en los ejes X, Y y Z, ya que el método especifica que 

deben haber unas aceleraciones iniciales. 

Las investigaciones han indicado que las frecuencias naturales de los 

modos de vibración en una vibración libre, no son la mejor base para 

un análisis de superposición modal de estructuras sujetas a cargas 

dinámicas. Ha sido demostrado por (Wilson, Yuan, and Dickens 1982) 

que el análisis dinámico basado en los vectores de carga-

dependientes de Ritz conducen a resultados mas precisos que el uso 

de los modos naturales (Autovalores-Autovectores) para un mismo 

número de modos. 

Cargas aplicadas en  
este caso de análisis 

Tipo de 

Análisis 

Caso de 
Análisis 



Los vectores de Ritz conducen a excelentes resultados porque ellos 

son generados tomando en cuenta la distribución espacial de las 

cargas dinámicas, cuando el uso directo de Autovalores y 

Autovectores (Modos naturales de vibración) desprecia esta 

información tan importante. 

 

 

 

Análisis Sísmico 

Se crean los casos de Sismo. El Capítulo 8  Articulo 8.6 punto A de la 

norma Venezolana Covenin 1756-1:2001 para “Edificaciones 

Sismorresistentes”, especifica que el sismo se aplicará primero como 

la raíz cuadrada del cuadrado de la suma en ambos sentidos, y en el 

punto B se especifica que será el sismo en un sentido, mas el 30 % 

del sismo en el otro sentido. Para cumplir con el punto A de la norma 

sísmica se creará sólo un caso a analizar llamado sismo. 

 



 

 

Luego se debe hacer clic en Modify./Show Case donde aparecerá la 

ventana que se muestra a continuación. En ella, se seleccionarán los 

sentidos del sismo U1 para X y U2 para Y, respondiendo estos a la 

Function espectro. El factor de escala será la aceleración de la 

gravedad. Por otro lado, se debe indicar que la combinación 

direccional es SRSS. También se indica el 6% de excentricidad 

dictado en el capitulo 9 sección 9.6.2.2 de la Norma para Edificaciones 

Sismorresistentes mencionada,  para así efectuar el efecto torsor. 

Debido al que el edificio es simétrico este efecto torsor no influye en la 

estructura. 

 

 

 



 

 

En caso  de que se desee aplicar el punto B de la norma sísmica 

mencionada anteriormente, se debe crear dos casos en Analisys 

Cases: uno llamado Sismo X y otro Sismo Y. Al entrar en 

Modify./Show Case, para el caso de Sismo X debemos introducir el 

valor U1 completo y luego el 30 % de U2 y viceversa para Sismo en Y.   

Combinación Modal 

Dirección Del Espectro U1= X y U2 = Y 
Factor de Escala 9,81 m/sg2 

Combinación 
Direccional 

SRSS Suma de 
los cuadrados. 

ABS Suma 
absoluta 

Excentricidad 



Combinación Modal: 

Se usa para combinar las respuestas modales en el análisis espectral. 

La elección depende del criterio del Ingeniero Calculista.  

 

- CQC:. Esta técnica de combinación modal toma en cuenta, el 

acoplamiento probable entre modos muy cercanos, causados por el 

amortiguamiento modal que incrementa el acoplamiento entre modos 

muy cercanos.  

 

- SRSS: Este es el método de la Raíz Cuadrada de la Suma de los 

Cuadrados. Esta técnica de combinación modal no toma en cuenta el 

acoplamiento entre modos como lo hacen los métodos del CQC O El 

GMC. 

 

- ABS: Este es el método absoluto. Esta técnica de combinación 

modal simplemente combina  los resultados modales tomando la suma 

de sus valores absolutos. Este método es usualmente conservador. 

 

- GMC: Este es el Método General de Combinación Modal, también 

conocido como el método de grupta. Es semejante al CQC si se toma 

en cuenta el acoplamiento de modos cercanos, y también incluye la 

correlación entre modos con contenido de respuesta rígida.  

 

Combinación Direccional: 

Para cada desplazamiento, fuerza o esfuerzo en la estructura, la 

combinación modal produce un resultado único positivo para cada 

dirección de aceleración. Estos valores direccionales para una 

cantidad de respuesta dada, son combinados para producir un 



resultado único positivo. Las dos opciones disponibles para 

combinación direccional son las siguientes: 

 

- SRSS: Combina los resultados tomando la raíz cuadrada de la suma 

de los cuadrados. Este es el método recomendado para la 

combinación direccional. 

 

- ABS: Este es el método de escala absoluta. Aquí los resultados 

direccionales son combinados tomando el máximo de todas las 

direcciones de la suma de los valores absolutos de la respuesta en 

una dirección más un factor de escala por la repuesta en la otra 

dirección. Nuestra Norma Venezolana indica como factor de escala el 

30% del valor absoluto de las solicitaciones más el 100% en la 

dirección ortogonal y viceversa. 

   

 

10.    Define → Mass Source… 

El origen de las cargas en SAP2000, se refiere a la determinación de 

las cargas sísmicas que participarán en el análisis dinámico, basado 

en los criterios establecidos en el capitulo 7 artículo 7.1” de la  Norma 

Venezolana Covenin 1756-1:2001 para “Edificaciones 

Sismorresistentes”, donde especifica que a la carga permanente se le 

añadirá el 100%, a la carga variable de los pisos el 25% y a la carga 

variable de techo 0%. 



 

 

 

11. Menú Draw 

Con esté menú se dibujará  toda la geometría de la estructura a 

analizar. Se puede acceder a ella por la barra de menú superior en 

Draw → Draw Frame/Cable/Tendon o haciendo clic en la barra de la 

izquierda al botón    . Con esta opción se trazará las vigas, 

columnas o arriostramientos. Para hacer esto, se selecciona todos los 

miembros correspondientes a vigas y luego se hace clic en el botón 

mencionado anteriormente. Automáticamente aparecerán las vigas y 

sus propiedades descritas en una ventana. 

 

De los Elementos (PP) y    

masas adicionales 

De las Cargas 

     De los elementos (PP),  
       masas adicionales 

        y las cargas 



 

  

Al hacer clic en el cuadro correspondiente a Section de esta ventana, 

se indica que estas son vigas y sus propiedades corresponden a las 

definidas en el paso 5. La funcion Replicate del menú Edit es de 

mucha ayuda para esto, ya que se puede realizar un sólo pórtico y 

replicarlo hacia los demás niveles, esta se encontrará en Edit → 

Replicate. Al hacer clic aquí aparecerá la siguiente ventana. Lo mismo 

se realiza para dibujar las columnas, pero se indica en Section la 

opción columna. 

 

 



 

   

En esta se define en qué dirección y distancia se quiere replicar los 

objetos seleccionados; colocando las distancias en los cuadros de dx, 

dy y dz. También cuantas veces se desea replicar en Increment 

Data. 

 



 

 

Al hacer uso de Draw Rectangular Areas del mismo menú o 

haciendo clic en se podrá dibujar las losas rectangulares de 

la estructura y en       para losas irregules. Estas últimas se 

definen seleccionando lo nodos donde se encuentra la misma. 

También la función Replicate es de ayuda en este caso. 

 



 

  

Se cargará la estructura aplicando el cápitulo 4 y 5 de la Norma 

Venezolana Covenin Mindur (Provisional 2002-88) “Criterio y acciones 

mínimas para el proyecto de edificaciones”  

 

 Entrepiso: 

  Carga Permanente. 

 Tabiquería   150 kgf/m2 

 Acabado Piso  100 kgf/m2 

 Friso      30 kgf/m2 

     

     280 kgf/m2 

  Carga Variable. 

 Áreas privadas  175 kgf/m2 

                                           Medico existenciales 

 

 



 

 

 Techo: 

  Carga Permanente. 

 Impermeabilización   3 kgf/m2 

 Tejas    100 kgf/m2 

      

     103 kgf/m2 

  Carga Variable. 

 P<15% y CP>50 Kg/m2 100 kgf/m2 

 

El peso propio de la estructura es tomado  en cuenta  por el programa 

para el análisis. 

 

 

12.  Asignación de las Cargas a la Estructura 

 

Para asignarle las cargas a la estructura se debe seleccionar las áreas 

a cargar para luego ir al menú Assign →Area Loads → Uniform 

(Shell)… Aquí aparecerá una nueva ventana donde se asignarán las 

cargas correspondientes, dependiendo si es para el entrepiso, techo o 

cualquier otra área a trabajar. 

 



 

Una vez cargadas las áreas anteriormente seleccionadas, se replican 

a los siguientes niveles y se procede a cambiar las cargas para el 

techo. 

 

13. Menu Assign → Area → Automatic Area Mesh… 

 

Para que el programa realice el análisis de forma correcta, las losas 

deben ser cargadas, es decir, se les debe asignar un Mesh, que se 

encargará de dividir las losas en áreas más pequeñas para que las 

cargas sean distribuidas a través de todas las vigas, esto se realiza 

porque el programa trabaja basándose en la teoría de elementos 

finitos. 

 

 

Tipo de 
Carga 
 

Magnitud 
de la 

carga 



 

 

 

14.  Diafragma  Rígido 

Para que el programa realice un análisis dinámico, se le debe asignar 

a la estructura un diafragma rígido, basándose en la Norma 

Venezolana Covenin 1756-1:2001 para “Edificaciones 

Sismorresistentes”, capítulo 8 sección 8.3.3. Para ello, se selecciona 

Assign → Joint → Constrains …  

 

Introducir 
Número de 

Divisiones 

Introducir 
Tamaño 

Máximo de 

la División 



 

 

Para asignarle un diafragma distinto a cada nivel, se debe seleccionar 

la opción Modif/Show Constrains  de la ventana anterior. 

 

 Y en esta nueva ventana se debe seleccionar Z Axis y asignarle un 

check a la última opción, para asignar un diafragma distinto a cada 

nivel. 

 

15.  Define → Combinations… 

 

Tipo  de 
Constraint 

a Agregar 

Diafragmas 
agregados 

uno por 

cada nivel 



Una combinación en SAP2000, también llamada “combo”, es una 

combinación de los resultados de uno o más casos de análisis. 

Cuando una combinación se define se aplica a los resultados para 

cada objeto en el modelo. Hay cuatro tipos de combinaciones: 

- Tipo Aditivo (Linear Add): los resultados de los casos del 

análisis incluido y combo son sumados. 

- Tipo Absoluto (Absolute Add): los valores absolutos de los 

resultados del caso de análisis incluidos son sumados. 

- Tipo SRSS (SRSS): se calcula la raíz cuadrada de la suma de 

los cuadrados de los resultados del caso de análisis incluido y los 

combos. 

- Tipo envolvente (envelope): se envuelven los resultados de 

los casos del análisis incluidos y combos para encontrar los valores 

máximos y mínimos. 

 

El programa toma las combinaciones que trae configuradas, pero 

estas pueden ser editadas para ser adaptadas a lo requerido por el 

diseño. Para ello, se debe hacer clic en menú Define → 

Combinations… donde aparece la siguiente ventana. 

 



 

 

Hacer clic sobre Add Default Design Combos…, para seleccionar el 

tipo de combinación según el material. 

 

 

 

 En este ejemplo se seleccionará Concrete Frame Design. 

 

Si se desea crear una nueva combinación, se puede seleccionar  

Modif/Show Combo… 

Tipo de 

Combinación 



 

 

En esta ventana se pueden definir otras combinaciones, modificando 

el tipo de carga y factor que la multiplica. 

 

16.   Antes de la corrida, se debe elegir bajo que norma se va a regir el 

diseño. Esto se hace en Options → Preferences → Concrete Frame 

Dising, en ella se selecciona Desing Code la norma utilizada en 

Venezuela, que en este caso es la ACI 318-05.  

 



 

17. Para analizar la estructura anteriormente preparada, se procederá  

hacer clic en  de la barra menú.      

 

 

 



Se presiona OK, y se abrirán nuevamente las dos ventanas que se 

tenían inicialmente, mostrando la deformada por carga permanente en 

la ventana 3D. 

 

18. Para considerar que la corrida ha sido óptima, se debe chequear que 

el factor de participación de masas logre que actue mínimo un 90 % 

de las masas de la estructura. Para saber si esto se cumple se busca 

en menú  Display → Show Tables. Esta ventana muestra todos los 

resultados obtenidos por el análisis, en este caso se examina 

Structure Output → Modal Information → Table: Modal 

Participation Mass Radius, y luego Ok. 

 

 

  

Esta ventana indica una tabla con los valores de participación. Se 

debe de verificar que la suma acumulada sea mayor al 90 %.  

 



 

De no ser así, se tendrá que volver al paso 9, específicamente en 

Analisis Modal para modificar el valor que corresponde a Maximun 

Number of Modes. De esta forma se aumentará la participación de 

las masas. 

 

A su vez se debe de chequear los desplazamientos laterales totales 

de la estructura como se indica en el capítulo 10 de la norma Sísmica 

Venezolana Covenin 1756-1:2001 para “Edificaciones 

Sismorresistentes”. Se busca la deformada de la estructura para el 

caso sismo en Display → Show Deformed Shape y luego se hace 

clic con el botón derecho del Mouse sobre el nodo de un piso para ver 

el desplazamiento de este, paso que se repite con el nodo del piso de 

abajo. Después se aplica el punto 10.1 y 10.2 de la norma para dar 

paso a la comparación de este valor con los valores limites de la tabla 

10.1. 

 



En el mismo menú Display, se podrán ver las diferentes gráficas de 

los distintos casos de cargas. Se accede de la siguiente forma   

Display – Show Forces/ Stresses… 

 

 

En esta opción se pueden ver los diagramas de corte, momento, 

fuerza axial y  esfuerzos en todas las direcciones de cada elemento. 

 

 

 

  

Al hacer clic en Frames/Cables… se pueden ver los diagramas de las 

distintas combinaciones. 

Mostrar las cargas asignadas 

 Mostrar las propiedades de algunos elementos 

 

Mostrar estructura sin deformaciones 

Mostrar deformaciones de la estructura 

 Mostrar diagramas de fuerzas y esfuerzos 

 Mostrar diagramas de trabajo virtual 

 

Mostrar tablas de resultados del análisis. 

 



 

 

  

Y al hacer clic con el botón derecho del Mouse sobre la barra deseada 

se  mostrarán los diagramas específicos de ésta. 

 

Caso de carga 

Tipo de Gráfica 



 

 

19. Para verificar el diseño de las columnas y las vigas, está la opción 

Desing → Concret Frame Desing → Start Desing/ Check of 

Structure. Con esta opción se analizará la estructura, verificando que 

cada elemento introducido cumpla con los cortes y los momentos que 

se generan de los distintos casos de cargas. También se indicará el 

porcentaje de acero que requieren cada una de las columnas, el 

acero positivo, negativo y trasversal de las vigas. Al hacer el análisis 

volverá a salir la estructura, esta vez aparecerá al lado de cada 

elemento el acero necesario y los colores,  anaranjado y verde para 

los que están verificados y rojo para los que no. Es importante 

cambiar la unidad a Kgf,cm, C para que las áreas de los aceros estén 

en cm2 y así facilitar su lectura. 

 



 

 

Al elegir una sección, ya sea una viga o una columna y hacer clic con 

el botón derecho del Mouse sobre está, se mostrará un reporte de 

este miembro, donde se indican los valores a los que está sometido el 

elemento en todos los casos de cargas. 

 

 



Con estos valores realizaremos el cálculo de los espesores de 

cabillas, así como su colocación. 

Si el control de los desplazamientos no cumple con el valor límite o por 

razones arquitectónicas se desea reducir el ancho de las columnas y 

esta nueva sección no resiste el corte producido por los distintos 

casos de cargas entonces se decide crear un muro de corte para 

compensar esto. Para este ejemplo, se empleo un muro de corte tipo 

C. 

Este muro estará ubicado en el área del cubo del ascensor por 

comodidad arquitectónica. 

 

Pasos para la creación del muro: 

 

A. Tal y como se hizo en el paso 6 de este mismo ejercicio, se 

definirá una nueva área en Define → Area Secction. Siendo en 

este caso, una losa maciza tipo Shell de espesor 40 cm que lleva 

el nombre de muro. 

 

B. En la planta baja del edificio se crearán cuatro vigas auxiliares que 

ayudaran a elaborar este muro tipo C. Inicialmente, se crearán 

muros completos y luego se eliminarán aquellas losas que 

corresponden a las puertas del ascensor.  

 



 

C. Se seleccionarán las cuatro vigas y se usará el comando Edit → 

Edit Lines → Divide Frames. Esta opción divide los elementos en 

un número de partes iguales. En este caso, se quiere dividir estos 

elementos en seis de un metro cada uno. Al hacer clic en la opción 

antes mencionada aparecerá la siguiente ventana. 

 

 

 

D. Obtenidas las divisiones, se seleccionarán todas las líneas 

generadas por estas divisiones para convertirlas en áreas, 

buscando en el menú Edit → Extrude → Extrude Lines to 

Areas. Al hacer clic aquí se obtendrá la siguiente ventana. 

 

Número de  
Divisiones 



 

Se quiere que las losas estén a cada metro, por lo que serán 3 por 

piso y 45 en todo el edificio. 

 

 

 

Tipo de Área a 

Convertir 

Distancia y Eje donde 

se Moverá el Área 

Cantidad de veces 

que se repetirá 



Es importante recordar que esto se está realizando en la estructura 

realizada anteriormente, por lo que se deben eliminar las vigas que se 

encuentran donde está ahora el muro, así como las columnas. 

Igualmente, se deben eliminar las losas de piso que quedan 

obstruyendo el paso del ascensor y las vigas auxiliares con las que se 

formó el muro. 

  

Después de ser eliminadas las vigas auxiliares, se deben seleccionar 

todos los nodos del muro y empotrarlos. Esto se realiza en Assing → 

Joints → Restraints.  

 

Como los muros son en C porque se debe dejar espacio para las 

puertas del ascensor, se selecciona en una de las caras del muro las 

dos losas centrales y las que tiene inmediatamente arriba de cada 

piso y se eliminan. Este espacio estará destinado a  las puertas del 

ascensor. Las losas que queden por encima del espacio creado se  

denominan dinteles y su función es consolidar el muro en esa 

dirección. Esta misma acción se repetirá para el muro paralelo. 

 



 

 

E. Se debe modificar el espectro de diseño, ya que la edificación 

ahora corresponde a una estructura Tipo III, según lo planteado en 

el capítulo 6 sección 6.3.1 de la norma Sísmica Venezolana 

Covenin 1756-1:2001  para “Edificaciones Sismorresistentes”. La 

clasificación del sistema estructural cambia de Tipo I a Tipo III, por 

tener muros estructurales de concreto armado. El factor de 

reducción de respuesta cambia a 4,5. Para realizar esta 

modificación se debe entrar en  Define → Funtion → Response 

Spectrum y hacer clic en Modif./Show Spectrum. Siguiendo el 

paso 8 de este ejemplo se introduce el nuevo espectro. 

 



 

 

F. Para poder realizar el paso siguiente se debe asignar un grupo al 

muro de corte. Se seleccionan las áreas del muro y sus 

empotramientos, de las cuales se quiere obtener sus fuerzas 

actuantes. En este caso será una sola de las C del muro de corte, 

ya que la otra tendrá los mismos valores. Luego, se debe ir a 

Assing → Assing to Group → Add New Group. 

 

 



 

En esta ventana se coloca el nombre del grupo en Group Name. En 

este ejemplo es MURO. 

 

 

 

G. Para obtener los valores de corte sobre el muro se debe ir a 

Define → Secction Cuts, al hacer esto se hace clic en Add 

Secction Cut 

 



 

 

  

Aquí  se indica la sección y resultados que se desean. 

 

   

Haciendo 
clic aquí se 

define la 

sección. 

Resultados que 

deseamos 

Unidad en 
la que se 

desean los 

resultados 

Nombre de la 

sección 

Tipo 
de 

área 
 

Grupo a 

analizar 



 

H. Luego de la corrida se irá a Display → Show Table, como se 

realizó en el paso 18 del ejercicio, sólo que esta vez, además de 

chequear lo que se hace en ese paso se buscará  ANALYSIS 

RESULTS → Structure Output → Other Output Ítems → Table: 

Section Cut Forces – Desing, donde saldrá la tabla con los 

resultados del análisis del muro. 

 

Con el Section Cut realizado se logra conocer el momento global 

a nivel de la base en el muro. 

 

 

 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Caso de 

Análisis 
Valores de 

Diseño 



III.2 Ejemplo 5 

 

Análisis y diseño sismorresistente de una estructura de Acero. 

 

 Edificio simétrico de 4 columnas  

en ambos ejes con una distancia 

entre ellas de 6 metros. 

 Número de pisos: 15 

 Altura entre pisos: 3m 

 Columnas HEB 200, Vigas IPE220 

 y Correas IPE 160. 

 

Solución: 

 

9. Selección de unidades. Ver paso 1 del ejemplo 4. 

 

10. File menú → New model. Ver paso 2 del ejemplo 4. 

 

11.  Definición de la estructura. Ver paso 3 del ejemplo 4. 

 

12. Define → Materials… Ver paso 4 del ejemplo 4. Seleccionar acero 

como material para este ejemplo. 

 

13.  Define → Frame Sections… seleccionar Import New Property e 

indicar Frame Section Property Type, Steel (Acero). Luego escoger el 

tipo de sección, en este caso será secciones doble T. Al hacer clic en 

la opción tipo doble T, se tendrán que importar las secciones, estas se 

encuentran en un archivo .TXT. Estas secciones varían dependiendo 

del sitio de fabricación en este caso son secciones europeas. 



 

 

 



 

 

Seleccionar los perfiles especificados. 

 

 

 

14. Define → Area Sections Ver paso 6 del ejemplo 4. 

 

15. Define → Load Cases… Ver paso 7 del ejemplo 4. 

 

16. Define → Funtions → Response Spectrum.. Ver paso 8 del ejemplo 

4. Recordar que el material a utilizar en este ejemplo es acero  

 

17. Define → Análisis Cases… Ver paso 9 del ejemplo 4. 

 

18. Define → Mass Source… Ver paso 10 del ejemplo 4. 



 

19. Menú Draw  Ver paso 11 del ejemplo 4, tener en consideración que 

las secciones corresponden a columnas HEB 200 y vigas IPE220. 

 

20.  Asignación de las Cargas a la Estructura. Ver paso 12 del ejemplo 

4. 

 

21. Menu Assign → Area → Automatic Area Mesh… Ver paso 13 del 

ejemplo 4. 

 

22. Diafragma  Rígido. Ver paso 14 del ejemplo 4. 

 

23. Define → Combinations… Se sigue el mismo paso 15 del ejemplo 4, 

pero al seleccionar Default Design Combos…, se indica Steel Frame 

Desing. 

 

24. Antes de la corrida, se debe elegir bajo que norma se va a regir el 

diseño. Esto se hace en Options → Preferences → Steel Frame 

Dising. En esta se selecciona Desing Code y la norma utilizada en 

Venezuela, que en este caso es la AISC-LRFD99. Para que la 

estructura sea un nivel de diseño 3 se indica en Framing Type la 

opción SMF (Special Moment Frame). Se debe aplicar la Norma 

Venezolana Covenin 1618:1998 “Estructuras de Acero para 

Edificaciones. Método de los estados Límites”  en el capítulo 18 

sección 18.2.1 para cambiar el valor de Demand/Capacity Ratio 

Limit de 0,95 a 1 y así satisfacer con las fórmulas de iteración N-M allí 

mostradas. Este debe ser un valor ≤ 1.0. 

 

25. Se realiza la Corrida. Ver paso 17 del ejemplo 4. 



 

26. Para considerar que la corrida es óptima se debe verificar el paso 18 

del ejemplo 4. 

 

27. Tal y como se verificó en el paso 19 del ejemplo 4, se verifica la 

estructura en Desing → Steel Frame Desing → Start Desing/ Check 

of Structure. Aparecerá la estructura con el diseño de colores 

mencionado en ese mismo paso. Para ver los valores de diseño se 

busca en Desing → Steal Frame Desing → Display Desing Info y se 

selecciona en Desing Output la opción P-M Ratio Colors & Values. 

 

 

 

Al hacer esto se muestra en pantalla las secciones con el valor 

obtenido de las ecuaciones de diseño que se encuentran en la Norma 

Venezolana Covenin 1618:1998 “Estructuras de Acero para 

Edificaciones. Método de los Estados Límites” Capítulo 18 

Sección18.2.1.  

 



 

 

A su vez se podrá hacer clic con el botón derecho sobre cualquier 

elemento para obtener la tabla con los valores que actúan sobre este. 

 

 



Los valores indicados en la presente tabla representan la ecuación de 

iteración mencionada anteriormente lo siguiente: 

RATIO → Resultado de la ecuación. 

AXL → Cociente de la fuerza axial. 

B-MAJ → Cociente de los Momentos en X. 

B-MIN → Cociente de los momentos en Y 

 

Igual que en el ejercicio 4,  se requiere disminuir corte en columnas. 

 

Se debe arriostrar la estructura en caso que se requiera disminuir el 

corte en las columnas o que el control de desplazamientos no cumpla 

con el valor límite. 

Se arriostra en los extremos de cada cara del edificio con correas tipo 

V invertida. 

 

 

Pasos para el arriostramiento: 

 

A. Se hace clic en el botón  donde se indica en la siguiente ventana 

que tipo de arriostramiento y sección se desea utilizar. 

 

 

Haciendo clic sobre el área donde se colocará el arriostramiento  

aparecerá automáticamente éste. 

 



B. Se debe de indicar que los extremos de los arriostramientos están 

articulados a la estructura. Para ello se seleccionan todos estos y se 

sigue el paso 5 del ejemplo 2.  Se debe restringir los momentos 22 y 

33 en ambos extremos y la torsión en uno de sus extremos, es 

indiferente el extremo que se desee indicar. 

 

C. Es importante recordar que el espectro cambia por ser una estructura 

aporticada. Seguir con el paso 8 del ejemplo 4. Aplicando la Norma 

Venezolana Covenin 1756–1:2001 “Edificaciones Sismorresistentes” 

capítulo 6 sección 6.3.1 la estructura es TIPO III con un factor de 

reducción de respuesta igual a 4, valor dado en la tabla 6.4, aplicada 

en concordancia con la sección 6.2.2. 

 

D. Se repite el paso 19 de este ejemplo y se comprueba que los valores 

de corte en los elementos disminuye. 

 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



CAPÍTULO IV 

LÍNEAS DE INFLUENCIA PARA CARGAS MÓVILES 

 

IV.1 Ejemplo 6: 

 

  Analizar la estructura aplicando líneas de influencia para cargas 

móviles. 

 

 

 

 

1. Selección de unidades: kgf, m, C. En la esquina inferior derecha como 

se indica en el ejemplo 1. 

 

2. Hacer clic en File menú → New model. Este menú muestra una 

ventana con diferentes tipos de modelos. Para este ejemplo se tomó 

un modelo tipo 2D Trusses. 

 



3. Este paso hace referencia a las dimensiones del Grid, así como las 

longitudes. Estas últimas variarán según las especificaciones del 

ejemplo.  

 

4.   Seleccionar los elementos que pertenecen a la línea de influencia y 

hacer clic en Define → Bridge Loads y seguir las tres primeras 

asignaciones que indica esta opción: Lanes…, Vehicles… y Vehicles 

Classes. 

 

 

 

 

 

 Lanes… En esta opción se deben asignar los elementos que serán 

sometidos a líneas de influencia. 

 

 

 

 



Hacer clic en Add New Lane Defined From Frames… donde aparece 

la siguiente ventana. 

 

 

En la ventana mostrada se agregan el número de elementos que 

actúan bajo la línea de influencia, para este caso son los tres 

elementos inferiores. También se asigna el nombre de Línea de 

Influencia en Lane Name.  

 

 Vehicless… 

 



 

Se debe indicar en Choose Vehicle Type to Add la opción Add 

General Vehicle y luego hacer clic en Add Vehicle. 

 

 

 

En la presente ventana se asigna el nombre a la carga en Vehicle 

Name  y se agrega la carga en Axel Load. Para este ejemplo se 



empleo una carga de 1000 Kgf. También se debe indicar en Load 

Length Type la opción Leading Load. 

 

 Vehicle Classes… Es esta opción  se indicará el factor de escala. 

 

 

 Al presionar Add New Class… en la ventana anterior y aparece la 

siguiente ventana. 

 

 

 

Se debe agregar el factor de escala al vehículo e indicar su nombre en 

Vehicle Class Name. 

 



5. Define → Analysis Cases… Hacer clic en Add New Case... para 

agregar un nuevo caso de carga. 

 

En esta ventana se debe seleccionar en Analysis Case Type la 

opción Moving Load y agregar una clase de vehículo en Vehicle 

Class. Se puede chequear en esta misma ventana los parámetros 

anteriormente señalados. 

6. Hacer clic en   de la barra menú, para analizar la estructura. 

 

7. Luego de realizar la corrida, hacer clic en Display → Show influence 

Lines/Surfaces… donde aparece la siguiente ventana. 

 

 



 

 

 

En la ventana mostrada se puede indicar el elemento y la componente 

que se desea, para así observar como influye la carga sobre éste a lo 

largo de la línea de influencia. Para este ejemplo, se indica la barra 

número 2 y la componente de la fuerza. 

 

 



 

También puede seleccionarse un nodo y la componente para éste. 

 

 

 

 

 
 
 
 
 
 
 
 
 



CAPÍTULO V 

MODELAJE DE ELEMENTO TIPO CABLE, 

COMPORTAMIENTO NO LINEAL. 

 

 

V.1 Ejemplo 7: 

 

  Modelar un elemento tipo cable, comportamiento no lineal. 

 TUBO-D159X4 para el poste de 6m de altura. 

 TUBO-D82.5X3.2 para los cables. 

 

 

 

28. Selección de unidades: kgf, m, C. En la esquina inferior derecha como 

se indica en el ejemplo 1. 

 



29. Hacer click en File menú → New model. Este menú muestra una 

ventana con diferentes tipos de modelos. Para este ejemplo se tomo 

un modelo tipo Grid Only. 

30. Este paso hace referencia a las dimensiones del Grid, así como las 

longitudes. Estas últimas variarán según las especificaciones del 

ejemplo.  

31. En la barra de menú principal se selecciona Define → Materials… 

Aquí se definirá el material con el que se va a trabajar. Ver paso 4 del 

ejemplo 4. En este ejemplo se trabajo con acero (steel). 

 

32. Define → Frame Sections… seleccionar Import New Property e 

indicar en Frame Section Property Type, Steel (Acero). Luego, 

escoger el tipo de sección, que en este caso será una sección tipo 

Pipe. Al hacer clic en la opción Pipe, se tendrán que importar las 

secciones, encontradas en un archivo .TXT. Estas secciones varían 

dependiendo del sitio de fabricación y en este caso son secciones 

europeas. En este ejemplo, se trabaja con TUBO-D159X4 para el 

poste y TUBO-D82.5X3.2 para los cables. 

 

33. Dibujar el poste y los cables. Ver paso 11 ejemplo 4. Se debe cambiar 

en la opción Section el tipo de tubo, recordar que la sección del poste 

es mayor que la de los cables.  

 

34. Los elementos tipo cable deben trabajar solo a tracción. Para ello, se 

debe indicar que la compresión es igual a cero, esto se realiza en 

Assing → Frame → Tension/Compresión Limits, colocando que la 

compresión es igual a cero. 



 

35. Indicar donde se desea colocar articulación y seleccionar la opción 

Assign → Joint → Restraints. Las articulaciones deben ir en la parte 

inferior del poste y los cables. 

 

36. Para colocar la fuerza aplicada en el poste, se debe indicar éste en el 

extremo superior y seleccionar Assign → Joint Loads → Forces. Ver 

paso 6 del ejemplo 1. 

 

37.  Para que el programa reconozca que la estructura es estable fuera 

del plano en el que se encuentra, se debe hacer clic en Analyze → 

Set Analysis Options … donde aparece la siguiente ventana. 

 



 

 

En esta ventana se debe seleccionar el caso Plane Frame XZ Plane. 

 

 

 

 

38.  Indicar caso No Lineal en Define → Análisis Cases. 

 

 



 

 Seleccionar Modify/Show Case… 

 

 

 

Indicar la opción no lineal en la ventana presentada. 

 

39.  Hacer clic en   de la barra menú, para analizar la estructura. 

40.  Este ejemplo se corre en caso lineal y no lineal para establecer 

diferencias entre ambos casos. 

 

 Caso Lineal 

 



 

 

Se observa que el caso lineal arroja valores inaceptables a 

compresión, ya que un elemento tipo cable sólo trabaja a tracción.  

 

 Caso No Lineal 

 

 
 
 
 



CAPÍTULO VI 

MODELAJE CON ELEMENTOS FINITOS DE LOSAS, 

ESCALERAS, TANQUES Y FUNDACIONES. 

 

VI.1 Ejemplo 8: 

 

Modelaje de una fundación tipo zapata mediante elementos finitos, 

empleando resortes en la base de la zapata para simular la acción del suelo 

sobre esta. 

 Losa de dimensión 2 x 2m y un espesor de 0,5 m. 

 Columna de sección rectangular de 0,3x0,30 m y 4 m de altura,   

 

 

 



1. Selección de unidades.  kgf, m, C, en la esquina inferior derecha 

como se indica en el ejemplo 1. 

 

2. Hacer clic en File menú → New model. Este menú muestra una 

ventana con diferentes tipos de modelos;  se debe seleccionar 

para este caso 3D Frames. 

 

3. Al seleccionar 3D Frames, aparecerá una nueva ventana donde 

se colocan las longitudes, número y altura del grid  a diseñar. 

Estas se definirán siguiendo el paso 3 del ejemplo 4. 

 

 

 

4. Define → Frame Sections… Al seguir el paso 5 del ejemplo 4 se 

podrá definir la columna a utilizar. Para este ejemplo, se utilizó una 

columna de sección cuadrada 30x30 cm. 

 

5. Define → Area Sections. Aquí se define el área de la losa. Paso 

6 del ejemplo 4. Para este ejemplo se tomó una losa tipo shell de 

0,5 m de espesor de dos metros de ancho y dos metros de largo. 

 



6. Luego, se procede a trazar el área de la losa y  la columna 

mediante el menú Draw. Al seguir el paso 11 del ejemplo 4 se 

podrá dibujar la losa y la columna. 

 

7. Al seleccionar el nodo superior de la columna y al hacer clic en 

Assign → Joint Loads → Forces… se asignaran las cargas que 

actúan.  

 

 

 

8. Se debe seleccionar la losa y hacer clic en Assign → Joint → 

Restraints para indicar la restricción de movimiento en el eje Z, 

porque se quiere simular el movimiento del suelo y éste sólo 

puede desplazarse en X y Y. 

 

 



 

 

9. Se debe dividir el área de la losa en varias partes iguales, debido 

a que cada resorte actúa sobre cada área definida. Para ello, se 

debe seleccionar el área de la losa y utilizar la opción del menú 

Edit → Edit Area → Divide Areas… donde aparecerá la siguiente 

ventana y se indicará en la opción Divide Area Into This Number 

of Objects el número en que se desea dividir la losa. En este 

ejemplo se divide la losa en 6 partes iguales. 

 



 

 

10.  Assign → Area → Area springs. Esta opción se utiliza para   

indicar el uso de resortes. En este caso a la losa diseñada. 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Es importante recalcar que se emplean resortes, porque estos simulan 

el efecto que origina el comportamiento del suelo sobre la losa. Por 

ello, se indica 1 como unidad de área que cubre el resorte y se 

selecciona la opción Compression Only, dado que el suelo solo 

brinda resistencia a compresión. La ubicación de los resortes debe ser 

Bottom, porque se quiere que los resortes trabajen por debajo de la 

Opciones para 
agregar, reemplazar 

o borrar resortes 

existentes. 

Ubicación 

del Resorte 

Dirección de la 
tensión del 

Resorte 

Tipo de 

Resorte Unidad 
de área 

que 
cubre el 

resorte 

Resistencia 

del resorte 



losa. Por otro lado, la dirección de estos resortes es Inward, porque 

se requiere que brinden resistencia hacia el interior de la losa. Se 

debe cambiar las unidades de Kgf, m, C a Kgf, cm, C para facilitar la 

lectura de los resultados. 

 

11.  Clic en Define → Analysis Cases…  

 

 

  

 Seleccionar Modify/Show Case… 

 



       

                    

Se debe seleccionar la opción Linear o Nonlinear, dependiendo del 

caso que se vaya a correr. Para este ejemplo, se correrá de ambas 

formas para establecer comparaciones. 

 

12.  Clic en   para correr el programa. 

 

13.  Luego de realizar la corrida, hacer clic en Display → Show 

Forces/Stresses → Joint en el caso DEAD, para ver los 

resultados del análisis realizado por el programa. 

 

Al correr en condición Lineal se obtendrá: 

 



 

 

 

 

 

 

 

 

Al correrlo por condición No Lineal 

 



 

 

 

Se puede observar  la diferencia existente entre el caso Lineal y No 

Lineal, donde uno de ellos toma fuerzas no correspondientes al 

comportamiento idóneo del suelo. 

El caso No Lineal simula de forma correcta el comportamiento del 

suelo, porque solo estudia la deformación  a compresión. Esto puede 

verse en la corrida realizada, ya que disminuye el área de la losa a 

compresión pero aumenta el valor de esta reacción, indicando que se 

encuentra a tracción. A diferencia del caso Lineal que arroja un 

resultado incorrecto, porque incluye reacciones de tracción que no 

efectúa el suelo. En el análisis de este caso se observa que el área de 

la losa a compresión es mayor pero el valor de la reacción es menor, 

lo que indica que la losa puede levantarse.  



Es importante realizar un estudio previo hecho manualmente, para ver 

cómo se comporta el suelo con respecto a la losa. Para esto se usa la 

siguiente fórmula: 








 


B

e

A

P 6
1  

Donde: 

P =  Carga aplicada 

A = Área de la zapata 

e = Excentricidad (Momento/Carga) 

B =  Dimensión de la zapata, que va en dirección del momento. 

 

Con esta fórmula se busca el esfuerzo máximo empleando el signo 

positivo y el esfuerzo mínimo con el signo negativo.  

 

Se debe verificar que: 

 e < B/6   La zapata esta sometida a compresión 

 e > B/6   La zapata esta sometida a tracción. 

 

















 


2

100000

420000

61
40000

100000
  

 4,215,2   

e → 
6

2
8,0    está sometida a Tracción. 

 

A través de esta demostración manual se puede comprobar que el 

resultado arrojado por el programa Sap 2000 es correcto.  

 



14. Para obtener los valores de diseño de la zona mostrada en la 

figura, se selecciona esta y se le asigna un grupo siguiendo el 

paso G del ejemplo 4. Seleccionar en Section Cut Local Axes la 

opción Slab. 

 

 

 

 Para luego repetir el paso H del ejemplo 4. 

 



 

 

La tabla presentada puede ser exportada a Excel, haciendo clic en 

File → Export Current Table → To Excel. Se abrirá un libro de 

Excel con los valores. 

 

 
 
 
 
 



VI.2 Ejemplo 9: 

 

  Modelaje de una escalera con Elementos Finitos.  

 

 

 

Solución: 

 

1. Selección de unidades.  kgf, m, C, en la esquina inferior derecha como 

se indica en el ejemplo 1. 

 

2. Hacer clic en File menú → New model. Este menú muestra una 

ventana con diferentes tipos de modelos. Para este caso se debe 

seleccionar 3D Frames. 

 

3. Al seleccionar 3D Frames, aparecerá una nueva ventana donde se 

colocan las longitudes, número y altura del grid  a diseñar. Estas se 

definirán siguiendo los pasos del ejemplo 4. 

 



4. Define → Area Sections. Aquí se define el área de la losa. Paso 6 del 

ejemplo 4. Para este ejemplo, se tomó una losa tipo shell de 20 cm de 

espesor. 

 

5. Luego se procede a trazar el área de la losa mediante el menú Draw. 

Al seguir el paso 11 del ejemplo 4 se podrá dibujar la losa. 

 

6. Hacer clic en Edit → Edit Area → Divide Areas… Seguir el paso 9 

del ejemplo 6. En este ejemplo, se divide la losa en 8X16. 

 

7. Asignar un mesh al área de la losa en Menu Assign → Area → 

Automatic Area Mesh… Seguir paso 13 del ejemplo 4. 

 

8. Se debe empotrar la escalera en el arranque y llegada de la misma  

Se selecciona la losa y se hace clic en Assign → Joint → Restraints, 

indicando la imagen de empotramiento. 

 

9. Seleccionar todas las áreas para asignarles la carga viva en  Assign 

→Area Loads → Uniform (Shell)…Seguir paso 12 del ejemplo 4. 

Aplicando el cápitulo 5 tabla 5.1 de la Norma Venezolana Covenin 

Mindur (Provisional 2002-88) “Criterio y acciones mínimas para el 

proyecto de edificaciones” la carga viva correspondiente a una 

escalera es igual a 500 Kgf/m2. 

 

10.   Para analizar la estructura hacer clic en  de la barra menú.      

 

11.  Luego de realizar la corrida,  se podrá obtener los valores de 

momentos para el diseño de la misma, en el menú Display → Show 

Forces/Streses → Shells. 



 

 

 

 

Con la ventana presentada, se podrán obtener las distintas fuerzas 

aplicadas sobre la estructura. En este caso se indican los momentos 

sobre la escalera. 

 



 

 

También se reportan valores como cantidad de acero, utilizando la 

misma ventana. Se selecciona cambiando en Component Type a 

Concrete Design y en Component se selecciona Ast1 o Ast2 

dependiendo del eje que se desee. 

 

 



 

 

 

 

 

12. Se buscan los valores de diseño de la zona mostrada en la figura.  

 

 



 

Seguir el paso 14 del ejemplo 8. 

 

 

 

 

 

Donde se muestra la tabla anterior en Excel: 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



VI.3 Ejemplo 10: 

 

Modelaje de un tanque de agua subterráneo con elementos finitos. 

Dimensiones del tanque: 

 Ancho= 8m 

 Alto = 4m 

 Profundidad= 6m 

 

 

 

41. Selección de unidades. Ver paso 1 del ejemplo 4. 

 

42. File menú → New model. Seleccionar Wall. 

 Definición de la estructura.  

 



 

43. Se presenta en la pantalla una de las paredes del tanque. Para dibujar 

el resto del tanque se hace uso de las opciones  Replicate y Extrude 

ubicadas en el menú Edit. Ambas opciones explicadas en el ejemplo 4 

paso 11 y punto D respectivamente. 

 

44. Define → Area Sections  Se deben definir el área de las losas tipo 

shell del tanque, las cuales corresponden a 0,20m para el techo, 

0,30m para las paredes y 0,35 para la losa de piso. Ver paso 6 del 

ejemplo 4. 

 

45. Hacer clic en View → Set Display Options  

 

 

 



En la ventana presentada, se debe colocar un check  en la opción  

Local Axes ubicado en la sección  Áreas, para así mostrar los ejes 

locales en que se encuentran en cada área de las paredes del tanque. 

La dirección del eje 3 (Eje Azul) debe ir hacia fuera del tanque, de no 

ser así seleccionar las áreas que no cumplan y hacer Assing → Area 

→ Reverse Local 3. 

Es importante realizar este paso, puesto que el tanque se encuentra 

sometido a presiones de agua que deben ser indicadas de  forma 

correcta en los ejes locales, así el programa simulará correctamente el 

empuje que realiza esta sobre las paredes. 

 

46. Define → Load Cases… Agregar los casos de presión de agua y 

presión del suelo. Asignar a cada caso la opción Other en Type. La 

opción Other no mayora el caso de carga. Ver paso 7 del ejemplo 4. 

 

 

 

47.  Seleccionar las paredes del tanque y hacer clic en Assign →  Joint 

Patterns… 

Joint Patterns es el patrón de cómo varía la presión del agua sobre 

los nodos. La presión del agua no actúa de forma uniforme, sino como 

una fuerza que aumenta dependiendo de la profundidad, razón por la 

cual se manifiesta como una ecuación lineal, donde el término 



independiente es igual a hagua  . En la ventana que se muestra, se 

indica la presión del agua en Pattern Name y se asignan los valores 

de la ecuación correspondientes a este modelo. Ax y Ay son cero 

porque el aumento de la presión del agua es en el eje z, Cz es igual a 

-1000 porque es la pendiente y D es 1000*4. 

 

 

 

48. Assign → Area Loads → Surface Pressure (All)… 

Asignar  la presión del agua e indicar en By Joint Pattern el factor 

multiplicador igual a uno. 

 



 

 

49. Seleccionar las paredes del tanque y hacer clic en Assign →  Area 

Loads → Surface Pressure (All)… 

El empuje que realiza el suelo sobre el tanque es de distinta magnitud 

al generado por el agua y en sentido contrario. La presión del suelo 

viene dada por el factor de equivalencia igual a: 

agua

suelosueloK




 Donde, para este ejemplo se empleo: 

sueloK = 0,40  

 suelo = 2000 kgf/m3 

El factor es igual a -0,8 

 



 

 

50.  Se debe cargar la losa de piso con el peso del tanque lleno, para ello 

se repite el paso 12 del ejemplo 4. Con una carga uniforme de 4000 

kg.  

 

 

51.  Hacer Clic en    para analizar el ejemplo. 

 

52. Para obtener los valores de diseño, hacer clic en Display → Show 

Forces/Stresess → Shells. Ver paso 11 del ejemplo 9. Aquí se 

muestran las fuerzas, dependiendo de las presiones que actúan sobre 

las paredes del tanque, así como la cantidad de acero que este 

requiera. 



 

Momentos para presión de agua 

 

 

Aceros para presión de Suelo 

 

53. Se repite el paso 14 del ejemplo 8 en la zona mostrada. En el piso del 

tanque. 

 



 

 

Seguir el paso 14 del ejemplo 8 

 

 

 

 

  Donde se muestra la tabla anterior en Excel: 



 

 

 

Es importante saber que todos los ejemplos planteados en este 

manual se realizaron solo para solicitaciones estáticas. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



CONCLUSIONES  
 

 
 Aunque idear un manual explicito de un programa como el SAP2000 

es una herramienta de gran importancia para cualquier persona que desee 

realizar diseños estructurales, es importante resaltar que el buen desempeño 

y manejabilidad del programa depende del usuario, puesto que para  manejar 

e interpretar los resultados arrojados por el programa se debe tener 

conocimientos previos de diseño estructural y contar con la aplicaciones de 

las normas venezolanas. 

 

 Es recomendable emplear el estudio de estos programas de análisis 

de diseño estructural en cátedras que impartan el estudio de estructuras, ya 

que son un instrumento de gran utilidad que se esta implementando con 

mucho auge en la actualidad 
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ANEXOS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



DESCRIPCIÓN DE LOS ICONOS DE LA BARRA PRINCIPAL 

 
 

     New Model. Empezar un nuevo modelo 

 Open… Abrir un archivo SAP 2000 existente 

 Save Model. Salvar el modelo actual. 

 Print Graphics. Imprimir Gráficos. 

 Undo. Deshacer el último cambio. 

 Redo. Rehacer el último cambio. 

 Refresh Window. Renovar la ventana actual usando los últimos 

datos. 

 Lock/Unlock Model. Cerrar un modelo contra cambios para 

protegerlo. 

 Run Anlysis. Ejecutar el análisis. 

 Zoom Restore. Acercamiento visual definido por el Mouse. 

 Full View. Restaurar la vista del modelo completo 

 Restore Previous View. Resturar la vista previa del modelo. 

 Zoom  In. Acercamiento visual. 

 Zoom Out. Alejamiento Visual. 

 Zoom Realtime. Acercamiento o alejamiento. 

 Pan. Mueve dinámicamente la estructura en cualquier dirección. 

 Set Default 3D-View.  Muestra el modelo en tres direcciones. 



 Set XY View. Muestra el modelo en dos direcciones paralelo al plano 

XY. 

 Set XZ View. Muestra el modelo en dos direcciones paralelo al plano 

XZ. 

 Set YZ View. Muestra el modelo en dos direcciones paralelo al plano 

YZ. 

 Rotate 3D View. Brinda una visión rotatoria 3D a la estructura. 

 Perspective Toggle. Perspectiva en tres direcciones. 

 Move Up in List. Sube una línea del grillado en un plano. 

 Move Down in List. Baja una línea del grillado en un plano. 

 Object Shrink Toggle. Disminuye los elementos para mejor 

visualización de las conexiones. 

 Set Display Options… Ajustar la visibilidad para ver las propiedades 

de los elementos. 

 Assign to group. Asignar a un grupo. 

 Cut. Cortar elementos seleccionados 

 Copy. Copiar elementos seleccionados. 

 Paste. Pegar  

 Delete. Borrar elementos seleccionados. 

 Replicate. Replicar elementos seleccionados en la dirección indicada. 

 Align Points…  Alinea los puntos.  

 Move Points/Lines/Areas… Mueve el elemento seleccionado en la  

dirección indicada. 



 Mesh Area. Divide areas. 

 Join Frames. Une los elementos seleccionados. 

 Divide Frames. Divide los elementos seleccionados. 

 Points and Grids Intersecctions. Ayuda a seleccionar puntos en las 

intersecciones del grid. 

 Ends and Midpoints. Selecciona puntos en extremos y puntos 

medios. 

 Intersections. Ayuda a seleccionar puntos característicos en  

intersecciones 

 Perpendicular Projections. Ayuda a seleccionar puntos 

característicos entre elementos perpendiculares. 

 Lines and Edges. Ayuda a seleccionar líneas y extremos. 

 Fine Grid.  Busca Grid. 

 Set Select Mode. Selecciona los elementos individualmente o dentro 

de  

una ventana. 

 Set Reshape Element Mode.  Modifica la forma del área. 

 Draw Special Joint. Dibuja nodos 

 Draw Frame/Cable Element. Dibuja un elemento FRAME 

localizándolo en la esquina. 

 Quick Draw Frame/Cable Element. 

 Quick Draw Braces. Dibuja arriostramientos. 

 Quick Draw Secondary Beams. 

 Draw Quad Area Element. Dibuja elementos 



 Draw Rectangular Area Element. Dibuja areas rectangulares. 

 Quick Draw Area Element. Dibuja un elemento tipo área 

directamente  

sobre el grillado. 

 Draw Solid. Dibuja Sólidos. 

 Select All. Selecciona todos los elementos. 

 Get Previous Selection.  

 Clear Selection. Deja libre todos los elementos seleccionados. 

 Select Using Intersecting Line. Selecciona elementos mediante la 

intersección de una línea. 

 


